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Safety Guidelines

This document contains notices which you should observe to ensure your own personal safety as well as to avoid property damage. The
notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices referring to property damage only
have no safety alert symbol.

Danger

indicates an imminently hazardous situation which, if not avoided, will result in death or serious injury.

Warning

indicates a potentially hazardous situation which, if not avoided, could result in death or serious injury.

Caution

used with the safety alert symbol indicates a potentially hazardous situation which, if not avoided, may result in minor or mod-
erate injury.

> B> B

Caution

used without safety alert symbol indicates a potentially hazardous situation which, if not avoided, may result in property dam-
age.

Notice

used without the safety alert symbol indicates a potential situation which, if not avoided, may result in an undesirable result or
state.

When several danger levels apply, the notices of the highest level (lower number) are always displayed. If a notice refers to personal
damages with the safety alert symbol, then another notice may be added warning of property damage.

Qualified Personnel

The device/system may only be set up and operated in conjunction with this documentation. Only qualified personnel should be allowed to
install and work on the equipment. Qualified persons are defined as persons who are authorized to commission, to earth, and to tag cir-
cuits, equipment and systems in accordance with established safety practices and standards.

Intended Use

Please note the following:

Warning

This device and its components may only be used for the applications described in the catalog or technical description, and
only in connection with devices or components from other manufacturers approved or recommended by Siemens.

This product can only function correctly and safely if it is transported, stored, set up and installed correctly, and operated and
maintained as recommended.

Trademarks

All designations marked with ® are registered trademarks of Siemens AG. Other designations in this documentation might be trademarks
which, if used by third parties for their purposes, might infringe upon the rights of the proprietors.

Copyright Siemens AG 2014 All rights reserved.

Reproduction, transmission or use of this document or its contents is not permitted without express written authority. Offenders will be
liable for damages. All rights, including rights created by patent grant or registration of a utility model or design, are reserved.

Disclaimer of Liability

We have checked the contents of this document for agreement with the hardware and software described. Since deviations cannot be
precluded entirely, we cannot guarantee full agreement. However, the data in the manual are reviewed regularly, and any necessary cor-
rections will be included in subsequent editions. Suggestions for improvement are welcomed.

Siemens AG

Industry Sector

P.O. Box 4848

90327 Nuremberg Siemens AG 2014
Germany Technical data subject to change
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1 Preface

1.1 Purpose of this Document

This document provides an introduction and supports you when commissioning and using the software
e [ON SIMATIC S7 PN
of the CMS X-Tools product line.

1.2 Basic Knowledge required

In order to understand this manual, general knowledge of automation technology and software packages CMS
X-Tools (in the following, X-Tools), STEP 7, S7-SCL, S7-CFC is required.

In addition, you must be familiar with network technology (UDP/IP) and with using computers with Windows.

1.3 Validity of this Document

This document is valid for the following software:
e CMS X-Tools ION SIMATIC S7 PN V 01.03
During the following pages, this software will be referred to by the term ION SIMATIC S7 PN.

1.4 Terms
The following terms are used within this document:
Definition |Description
CP Communication Processor
DB Data Block
FB Function Block
ION I/O-Node
OB Organization Block
UIK Universal Identification Key
SW Software

English
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CMS X-Tools

2 Scope of Delivery

2.1 Scope of Delivery

What is shipped?
e CD
CMS X-Tools ION SIMATIC S7 PN - Software & Documentation

2.2 Unpacking and checking

After unpacking, please check
¢ the packet for completeness and

¢ all parts for transport damage.

Caution
Do not use any content / parts that show evidence of damage!

English
Release 2015-06
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3 Product Characteristics

3.1 What is CMS X-Tools?

CMS X-Tools is an industrial-suited Condition Monitoring System for technical and technological services in
industrial plants. X-Tools is a modular, scalable analysis and diagnosis system. It is optimized for reaction less
measurement of analog, binary and numerical data. X-Tools can be integrated in existing and new industrial
plants.

X-Tools can be integrated into the TIA-Architecture:

cRSP, ISB Network

CMS
X-Tools Client SIMATIC MS SIMATIC S7-400
WAN @ : e |
[ le 5 Saine | (el
PR ST -
E @

CMS X-Tools
Microbox [ IPC

" Ethernet

" PROFIBUS

= IEEE1394

= SW Nod
I

I siPLUS cMs SIMOTION SIMATIC S7-300 SIMATIC TDC
Profibus Spy

| el ° ]
SIPLUS CMS4000 I — B
Drive/Gear u E &l
! =l

Up to 180 Sensors g g

SIMATIC SIMATIC SIMATIC
WinAC RTX 57-1200 57-1500

Figure 1: Overview of the Components of X-Tools

3.2 Introduction

The ION SIMATIC S7 PN is used in order to acquire data from a SIMATIC S7 PN controller (S7-300, S7-400, or
WinAC) and to transmit the recorded data via Ethernet (UDP) to a superior industrial PC. After the engineering,
the ION SIMATIC S7 PN is used for the transmission of measurement data to X-Tools.

The usage of an ION SIMATIC S7 PN allows transmitting up to 712 byte of data. The data is divided into 178
channels and each channel consists of 32 bit (DWORD), where several signals can be merged to a channel.

The ION SIMATIC S7 PN consists of a function block which must be engineered into a SIMATIC S7 PN control-
ler with an integrated PROFINET interface.

3.3 Hard- and Software Requirements

Hardware
e PC
o the hardware demands of the PC are dependent to the used software
¢ SIMATIC Controller with integrated Ethernet / PROFINET interface
0 CPU 41x-3 PN/DP

English
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CMS X-Tools

o CPU 31x-2 PN/DP
o CPU 319-3 PN/DP
0 41x-5H PN/DP

0 WInAC RTX

¢ Ethernet connecting cables

Software
e CMS X-Tools Professional (V 03.01 SP1 or higher)
e STEP7 (using V 5.4 + SP5 or higher)

3.4 Ordering Numbers

Article

Ordering Number (MLFB)

CMS X-Tools Professional V 04.02

9AE4160-1AB00

Further information is obtained from your local Siemens office and from the homepage

http://www.siemens.com/siplus-cms.

English
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4 Block Description

4.1 Function

The ION SIMATIC S7 PN is used in order to acquire data from a SIMATIC S7 PN controller and to transmit the

recorded data via Ethernet (UDP/IP) to a superior industrial PC. The ION SIMATIC S7 PN consists of a function
block (FB) which must be engineered into a SIMATIC S7 PN controller with an integrated PROFINET interface.

The communication protocol is UDP/IP.

The FB is called in a cyclic interrupt (e.g. OB35) and allows transmission of up to 712 byte of data each cycle.
The data is divided into 178 channels and each channel consists of 32 bit (DWORD). The channels are filled
with data in the S7 program. It is possible to merge several signals into one channel (e.g. two WORD signals).

A relative timestamp is automatically added to the transmitted data. Two different ways for the internal
timestamp generation are possible. These can be selected by the input TIME_BASE. When using the system
clock-based timestamp generation, the timestamp is directly calculated by reading the clock of the S7-CPU. In
contrast to that, the timestamp is calculated out of the cycle time CYCLE_T in case of the counter-based time
base.

Whenever the clock of the S7-CPU is synchronized (e.g. by NTP), the counter-based time base is recommend-
ed to avoid errors in the time domain check of X-Tools.

The FB is called in startup OB (OB100, OB101, OB102) for initialization. Therefore the parameter COM_RST is
set to TRUE. During initialization the number of active channels is written, the cycle time is set and some other
calculations for service are done.

Afterwards a phase begins, in which the FB runs along passive in the program. Only after X-Tools attempts to
connect the FB is activated and it takes place data exchange with X-Tools. Details for engineering in X-Tools
you can find in the user manual of X-Tools.

When data transmission is started the signals are transmitted to X-Tools. Therefore the signals are buffered in
two buffers. Each buffer can store 712 bytes. With 178 active channels one buffer is transmission buffer and
one is the buffer for the current data. The buffers are alternating written and transmitted. If not all channels are
active more cycles can be buffered. With 89 active channels each buffer can buffer two measurement cycles,
the transmission is initialized after each two cycles. The communication load can be reduced.

4.2 Parameters
Parameter Declara- |Datatype Description
tion

COM_RST INPUT BOOL With ,True’ on this signal a reset of the FB is
forced. During runtime it should be ,False’.
The FB remains in initializing routine as long
as COM_RST is set to ,True'.

CYCLE_T INPUT INT Cycle time of calling alert in ms.

COMMAND_ID [INPUT INT ID for command connection (0x0001 ...
OxOFFF).

DATA_ID INPUT INT ID for data connection (0x0001 ... OXOFFF).

COMMAND_P |[INPUT WORD Local UDP port for command connection

ORT (0x07DO0 ... 0x1388).

DATA_PORT |INPUT WORD Local UDP port for data connection (0x07D0
... 0x1388).

DEV_ID INPUT BYTE Identifier for CPU type.

CURRENT _ INPUT INT Number of channels which are transmitted

CHANNELS to X-Tools each cycle (1 ... 178).

CHANNEL INPUT ARRAYI[0..1 | Array, which defines the channels which

77] OF shall be transmitted to X-Tools. A reading of
DWORD peripherals is not possible.
English
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Parameter Declara- |Datatype Description
tion

UIKO..UIK7 INPUT BYTE UIK of the ION SIMATIC S7 PN. See point
6.4 for details.

TIME_BASE INPUT BYTE Time base for timestamp generation
(O=system clock-based; 1=counter-based)

STATUS_CMD |OUTPUT |WORD Status word of TCON function for command

_TCON communication

STATUS_DAT |OUTPUT |WORD Status word of TCON function for data

A_TCON communication

English
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4.3 Conditions

During projecting of the ION SIMATIC S7 PN the conditions of all used components have to be respected. The
ION SIMATIC S7 PN must not be called in OB1.

The minimum cycle time of the calling OB as the number of channels which can be transmitted properly in this
time are specific for each project and hardly depending on SIMATIC CPU type and network usage. The used
configuration has to be checked for stability and must not operate at the limit, because in case of errors (e.g.
BUS errors) a higher CPU load must be expected.

Notice

Wrong project engineering can lead to errors or stop of the CPU.

English
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5 Installation

5.1 Installation of the Library

Insert the product-CD “CMS X-Tools” into the drive of your PC. Start the SIMATIC Manager and open via File >
Retrieve... the dialog for de-archiving of projects and libraries. Choose the path to your CD-drive and open the
archive file “CMS X-Tools ION SIMATIC S7 PN V 01.03.zip” from the product CD. Finally choose the target
directory and the storage path for the ION SIMATIC S7 PN library and confirm with OK.

F B

Retrieve (3280:754)

The following objects were retrieved:
& Projects: Mone

Libraries: [OM SIMATIC 57 PN

Do pou want to open these now?

Figure 2: De-Archiving Dialog

When de-archiving is finished apply the shown dialog on “Yes” to open the library. The library is installed proper-
ly. After successful installation, the engineering can begin.

& ION SIMATIC 57 PN (Component view) -- D:\Project\57 PN =n =R <=
EO IOM SIMATIC 57 P Object na.. | Syrnbolic name | Creat... | Sizeint... | Type | Wersion [Header] | Mame (Header) | Unlinked | Author | Mor-Fietain
[=-{z2 10N SIMATIC 57 PN SHFES [0 SIMATICSF PN 50 17430 Furction Block 17 |0 5 7PH j SIFLLS
(&) Cluelen ZFFBES  TCON STL 860 Function Block 22 TCON SIMATIC
Bausteine EFFEEF  TUSEND STL 416 Function Black, 22 TUSEMND SIMATIC
SHFEEE TURCY STL 472 Function Black 23 TURCY SIMATIC
SFC DT_TOD STL 242 Function 12 DT_TOD SIMATIC
&FSFC1 READ_CLK sTL — System function 1.0 READ_CLE SIMATIC
SFSFCE RD_SINFO STL — System function 1.0 RD_SINFO SIMATIC
§3SFC20  BLEMOY STL ~ System function 1.0 BLEMOY SIMATIC
rl [ ]

Figure 3: The ION SIMATIC S7 PN Library after the Installation

English
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6 Engineering in AWL

6.1 Copying the necessary SW Components

Opening of the Library

If the library was not opened automatically, go to the SIMATIC Manager and choose File > Open. In the next

dialog select the tab Libraries and choose the library “ION SIMATIC S7 PN”. Afterwards confirm in the dialog

with the “OK” button.

Open Project

LSS % 8 AT ==
User plDiBC€ Libraries I yample proiectsl Multipmiectsl

Marmne | Storage path -
& CFC Library C:\Program Files [#86\SIEMEMSA\STEPTAS Plibshcfolib
@ DRYPCST C:AProgram Files [#86NSIEMENSYSTER TS FlibshDivposy

|| 145 _MDL_vw2_0u D:\Project 8 GOR_2014_04_07MAS_AGORMAS_MDL_

| @ 145_MDL_v2 0 [:hProjectyaS_AGORNYAS_MDOL_
| & [OM SIMATI il D:4Praj
10N SIMATIC 57 PM C:\Program Files [«BEMSIEMEMSYSTERTAS FRIOMST_FN
@1L71_1205 Lib [:hProjecty1410a640L71_1205 8
.:l__._._... .- — — .__.._._.._.._._____.__.l.. mme = e
Selected
|lzer projects: l_
ll Libraries: l_'l
Sample projects: l_
Multiprajects: l_ Browse... |

Cancel | Help |

A

Figure 4: Opening of the ION SIMATIC S7 PN Library
To copy the necessary Components

Copy all SW components of the ION SIMATIC S7 PN. The SW components FB65, FB67, FB68, FC8, SFC6 and
SFC20 originate from the library “Standard Library” and can be copied from this source.

ﬂ SIMATIC Manager - [CMS X-TOOLS (Component view) -- D:\Project\CMS_X-TO]
% Eile Edit Inset PLC View Options Window Help

[F=5 EeR =)
[-]5][x]

D |37 | & 2@ |2 %% - (=1 |[ <No Fiter>

Sl RaE e M|

= CMS X¥-TOOLS Object name | Symbolic name

I Mame [Header]

| Version [Header]

| Created in language I Size in the work me... | Type

I Unlinked

B SIMATIC 418 PN
- cru s16-3PH/DP
B S741E3PN
{B Source
{£H Blocks
-] Charts

3 0B1

COMPLETE RESTART
il

01
01

Organization Black.

Press F1 to get Help.

[ |Realtek PCle GBE Family Controller.1| 13430 Bytes

Figure 5: The Components of the ION SIMATIC S7 PN
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6.2 Calling the Function Block - Startup OBs (OB100, OB101 and OB102)

Description

The component ION SIMATIC S7 PN must be connected in the Startup OBs, to allow a system restart when the
CPU initiates the restart.

The following table shows the available Startup OB types:

Type of Startup Corresponding OB
Hot restart OB 101
Warm restart OB 100
Cold restart OB 102

Check which Startup OBs are used by your CPU and which Startup OBs your application needs for proper ini-
tialization in all states. Maybe you need to implement more than one Startup OB. In the following part the im-
plementation of OB100 is shown as example.

Function Block call

If the OB100 is not available jet you must insert it into your program. For this, right Mouse click on the compo-
nent folder and select Insert new Object > Organization Block.

Properties - Organization Block @

General - Part 1 ] General - Part 2] Calls ] Attributes ]

Name: OB100

Symbolic MName: |COMPLETE RESTART

Symbol Comment: |Complete Restart

Created in Language: S

Project Path: LaboraufbautSIMATIC 416 PNVCPU 416-3 PN/DPAST7416-3PN

"Bausteins OB 100
Storage location

of project: D4Project’¥-TOCLS LABORLaborauf
Code Interface
Date created: 07/11/2014 03:06:07 FM
Last modified: 06/27/2011 01:27.04 FM 02/15/1996 04:51:10 FM
Comment: "Complete Restart” -

Cancel Help

Figure 6: Insert a new Organization Block

Open the OB100 via a double click and add a call of FB3. The assigned instance database can be freely select-
ed (select any free number, in the example DB31). Afterwards confirm in the dialog with the “Yes” button and
the DB is automatically generated by the SIMATIC manager.

CB100 : "Complete Restart"”

Comment :

CALL FB3, DB3l

Figure 7: Calling of FB3 in the OB100

English
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Now you must set the parameter COM_RST with TRUE to initialize the ION SIMATIC S7 PN. For the parameter
DEV_ID you must insert the identifier for your CPU according to the following table:

WIinAC RTX IF1 B#16#01
315-2 PN/DP, 317-2 PN/DP B#16#02
319-3 PN/DP B#16#03
414-3 PN/DP, 416-3 PN/DP, 41x-5H PN/DP (RackO0) B#16#05
WInAC RTX IF2 B#16#06
WiIinAC RTX IF3 B#16#0B
WInAC RTX IF4 B#16#0F
41x-5H PN/DP (Rack1) B#16#15

Afterwards save and close the component.

CALL "ION SIMATIC 57 PN" , "DB STBN 01" FB3 / DB31
COM_RST :=TRUE

CYCLE_T
COMMEND_ID
DATA_ID
COMMEND_EORT
DATA_PORT

DEV_ID :
CURRENT CHANNELS:
CHANNEL

UIED

UIEL

UIEZ

UIE3

UIE4

UIES

UIEE

UIET

TIME BASE
STATUS_CMD TCON :
STATUS_DATA TCON:

B#la#¥d

Figure 8: Initialized Parameter List of the ION SIMATIC S7 PN in the OB100
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6.3 Calling the Function Block - OB3x Cyclic Interrupts

Description

The acquisition and transmission of measurement data is done via a function call in a cyclic interrupt (OB3Xx).
The sample time matches the cycle time of this OB. It can be configured in HW Config. It is recommended to
use a cycle time between 10ms and 100ms.

Write data into the Transmission Channel

Insert new cyclic interrupt-OB into your program, or work on an existing one in your program. In the following
example OB35 is used.

The channels which can be observed will be supplied. There exists of up to 178 channels each having 4 bytes
per channel for a total of 712 bytes. The up to 178 channels are sent cyclically to the PC after X-Tools has con-
nected with the ION SIMATIC S7 PN. The current measuring data is determined by the configuration of these
up to 178 channels. For the beginning you must fill the data block. Therefore you have two options:

a) Load the data and transfer it directly into the destination channel in the DB. The editor produces the data-
base addresses automatically via input of the channel numbering in the format “DB3.CHANNEL [index].

b) All data can be written into an array which can be set to the input CHANNEL of the FB3 during block call.

OBZE - "Cyoclic Interrupt'

Hommentar :

Hommentar -

L DUFLEF19501224
T DE3. CHANNEL [01]

OEZE : "Cyolic Interrupt"”

Hommentar:

Fommentar:

L DWELE#12801224
T DE3.DED 1&

Figure 9: Filling of the Data
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Write Data into the Transmission Channel

When the channels are filled with data you can add an additional network and project your ION SIMATIC S7 PN
as follows:

CARLL "ICON SIMATIC 57 PN" , "DB_STPN 01" FBE3 / DB31

COM RST :="Reset 57 BN"

CYCLE_T :=#0B35_EXC_FREQ XC_FREQ
COMMAND ID =31

DATA ID :=32

COMMRND PORT :=W#le#7D0

DATA PORT =W#le#7DL

DEV_ID :=B#1645

CURERENT_CHARNNELS: =178

CHANNEL :=#Datenkanal #Datenkanal
UIED 1=Bi#lo$22

UIERL :=Bi#lo#eT

UIEZ 1=Bi#lo#42

UIE3 :=B#le#0

UIE4 :=B#le#0

UIES :=B#le#0

UIE& :=B#le#0

UIER7 :=B#le#l

TIME BASE 1=B#le#l

STATUS CMD TCON :
STRTUS DATR TCON:

Figure 10: Component Call in the OB35

In the cyclic interrupt COM_RST must be set to FALSE during runtime of the block. Enter for the parameter
CYCLE_T the temporary component variable OB3x_EXC_FREQ. This setting defines the cycle time of the inter-
rupt OB3x.

For the communication you need to specify connection IDs and port numbers. Enter for the parameter
COMMAND_ID a connection ID for the command connection (0x0001...0xOFFF) and for the parameter
DATA_ID a connection ID for the data link (0x0001...0xOFFF). Enter for the parameter COMMAND_PORT a
UDP port for the command connection (0x07D0...0x1388). As in the example port 2048 which can be selected
freely. Enter for the parameter DATA_PORT a UDP port for the data link (0x07DO0...0x1388). As in the example
port 2049 which can be selected freely.

Enter for the parameter DEV_ID the identifier for your SIMATIC S7 CPU according to the following list:

WInAC RTX IF1 B#16#01
315-2 PN/DP, 317-2 PN/DP B#16#02
319-3 PN/DP B#16#03
414-3 PN/DP, 416-3 PN/DP, 41x-5H PN/DP (RackO0) B#16#05
WIinAC RTX IF2 B#16#06
WInAC RTX IF3 B#16#0B
WInAC RTX IF4 B#16#0F
41x-5H PN/DP (Rack1) B#16#15

Enter for the parameter CURRENT_CHANNELS the channels to be transmitted per cycle (1...178). Attention,
also empty channels are transmitted.

For the parameter CHANNEL it is optional to enter a field which contains the measurement data. This is valid
only for 178 channels.

For the last inputs you have to configure the UIK of the ION SIMATIC S7 PN. Regard the following chapter for
details.
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6.4 UIK

Description

Each ION SIMATIC S7 PN must possess a unique number, the UIK. The UIK is used by X-Tools for the clear
identification of the ION SIMATIC S7 PN. The device name, which is shown by default in X-Tools, consists of
the device type and the UIK. Example:

¢ |ON SIMATIC S7 PN (000008-00-06010000).
The user can defined is own unique rule.
Assigning the UIK
It is formed via the MAC address of the hardware (6 bytes) and 2 user-defined bytes.

The parameters UIKO and UIK1 can contain a zero byte (B#16#0) in case there shall be only one ION SIMATIC
S7 PN under the specified MAC address. Enter the MAC address (must be in hexadecimal representation) for
UIK2 ... UIK7. In the following example the MAC address 08-00-06-01-00-00 is used.

% LAD/STL/FBD - [OB35 -- "CYC_INTS" -- Laboraufbau\SIMATIC 416 PN\CPU 416-3 PN/DP\..\OB35] o[- E- ]
iIF File Edit Insert PLC Debug View Options Window Help -] =
DEEEH &S bR i ol || | 25 6 e = : T | k2
Sl Contents Of: 'Environment\Interface\TEME'
B8 TEMP % [ Name Data Type Address |Comment |
-E9 New network Bl 0B3S_EV_CLASS E| OB35_EV_CLASS Byte 0.0 ‘Bits 0...
&3 FB blocks |.E 0B35_STRT INF _| | = oB3s_sTRT_1mE Byte 1.0 16436 ... =
i = 0B35_PRIORITY E o te
& FC blocks i B 7 £ 0B35_PRIORITY Byte 2.0 Priori...
&3 SFE blocks = 0B35_CB_NUMBR £ OB35_OB NUMBR Byte 3.0 35 (Or...
7 oc {1 |0B35. RESERVED] 1 't5) CB35_RESERVED 1 Byte 4.0 Reserv...
@ SFC blocks S T3} CE35_RESERVED 2 Byte 5.0 Reserv. ..
M Multiple instances VB ORAs PR SE OFFAET =) 0B35_PHASE OFFSET Word 6.0 Phase ...
=¥ Libraries [ On3s RESEAVED 3 - |=0B3s rEsErRvED 3 Int 8.0 Reserv...
.. Bl 0B35 EXC FREQ it i L B

[=RNetwork 7HREEAIN =

ION SIMATIC S7 PN (DB31, DB32, DB33) mit Ports 2000/2001, 2002/2003, 2004/2005

CALL "READ CLK"
RET_VAL:=$Return
CDoT r=#Startzeit

CALL "ION SIMATIC S7 PN" , "DB_S7PN 01"

COM_RST :="Reset 57 PN"

CYCLE T :=$0B35_EXC_FREQ - F execution (mse

COMMAND ID :=31 =

DATA_ID =32

COMMAND_PORT :=WELE4TD0

DATA_PORT 1=W#1647D1

DEV_ID :=B41645

CURRENT_CHANNELS:=178

CHANNEL :=¢Datenkanal

UTROD i=B#16422

UIEL :=3416467 Null Bytes

UIRZ :=B#le#42

UIE3 :=B#1640

UIR4 1=B1640 MAC Adresse

UIRS 1=B1640

UIERE :=B#1640

UIRT :=E#16#1

TIME_BASE i=BE¥16%1

STATUS_CMD_TCON :=

STATUS DATA TCON:= s
< [ 3

Figure 11: Assignment of the UIK

If multiple ION SIMATIC S7 PN are to be operated on a single hardware unit (over the same MAC address), it
must be ensured that each UIK is unique. Therefore, the 2 user-defined bytes can be used in order to give dif-
ferent values to each operated instances.
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6.5 Loading of Components

When you have finished you implementation mark / highlight all blocks of your project. Then select in the menu
PLC > Download or click on the appropriate symbol to load the marked / highlighted components into the CPU.
Then the CPU must be restarted (STOP > RUN) to initialize the ION SIMATIC S7 PN. Now the connection to
X-Tools can be initiated.

B File Edit Inset PLC View QOptions Window Help [—]=][x]
D |27 e & By | o |[@ 25 % & |['< Mo Fiter > -7 R@E BEM 2
—
[EF CMS =-TOOLS Object hame Symbiolic name
E-Ell SIMATIC 416 PN
=~ [l cPU 4163 PN/DP
(30 S7416:3PN
-[BD Source
(g8 Blocks
‘g8 Charts

DT_TOD
R n fu READ_CLE

Press F1 to get Help. [ [Realtek PCle GBE Family Controller.T| 13886 Bytes Y

Figure 12: Loading of Components
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7 Engineering in CFC
7.1 Modification of the ION_PN
Description

The component ION SIMATIC S7 PN cannot be directly placed in a CFC-plan. Instead a covering block
ION_PN (FB600) is placed in the CFC-plan and therefore calls the component ION SIMATIC S7 PN internally.
The SCL source of the ION_PN is delivered as a component of the library. Thus making it possible to project-
specifically adapt the interface to the transmitted data.

Modifying the SCL File

Open the library of the ION SIMATIC S7 PN and select in the folder Sources the SCL-Source ION_PN. Open
the SCL source per double click.

)| SIMATIC Manager - [ION SIMATIC 57 PN (Component view) -- D:\Praject\S7_PN] =N E=R<|
O File Edit Insert PLC View Options Window Help - & x
D& |57 ] 2y T < No Fiter > =% & BHEM K
=% 10M SIMATIC STPN Object name | Symbolic name | Type | Siee| Author | Last modified Comment

E-{E0 10N SIMATICS7 PN 10N PN ST source 11489 0B/20/2011 05:43:32 PM
(@] Quellen

-{gH Bausteine

Press Fl1 to get Help. Realtek PCle GBE Family Controller.T

Figure 13: Opening of the ION_PN
Modifying the SCL Code
1. The initial parameter DUMMY may not be changed, deleted, shifted or renamed.

2. Behind the initial parameter DUMMY are the initial parameters for the values which can be transferred.
Designations and data types of the variables may be project-specifically adapted. It is highly recommend-
ed in this case to provide the initial parameters with comments for the PCS7 attributes (e.g. to assign
S7_visible = false').

3. Make sure that the parameters projected behind the input variable DUMMY occupy a storage area at
least by CURRENT_CHANNELS x 4 byte per channel. CURRENT_CHANNELS can be changed for the
instance. Since the max. number of channels amounts to 178, the initial parameters should occupy 712
byte.

The remaining SCL code should not be changed!
Translate the Block

Translate the component in the SCL editor over file - translating.

Notice
If it is not possible to translate the CFC block check whether FB600 is listed in symbols as “ION_PN".

Notice

If the FB600 should be already present, before translating the existing FB600 must be deleted from the library
ION SIMATIC S7 PN and the symbolic name ION_PN must be assigned to a free module number. Secure the
changed SCL source ION_PN from ION SIMATIC S7 PN for later adjustments.
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3 5CL - [ION_PN -- ION SIMATIC S7 PNAION SIMATIC S7 PN] [ (]
File Edit Inset PLC Debug View Options Window Help [=]&]x]

Dlcs|@| 8| o] 5 |5|@ enlealala] o] || [T BS|m) w7|

@ [74]@6[+-[12 | [t |

%A%

//Description of function block:

//{This function block converts the input parameter CHANNELS of the block "ION SIMATIC 57 PN" from an "RRRAY of DWORD"™ to singl
//before the block "ICN SIMATIC 57 PN" is called. This makes it possible to call use the block "ION SIMATIC S7 PN" in the CFC
//The datatypes of the channels that are transferred to SIPLUS CMS X-Tools (input parameters behind DUMMY) can be changed. It .
//change the other code of the function block.

I

//WARNING:

//This blocks copies CURRENT CHANNELS*4 bytes from the variable DUMMY to an internal array.

//You must take care that there are enough data defined.l

FUNCTION BLOCK "ICHN_PN"

{57_tasklist := 'CB100"}

TITLE = 'PFC5 7 block FOR ION SIMATIC 57 FN'
NREME : ICN_FN

VERSION : '1.0'

KNCW_HCW_PROTECT
VAR INPUT

DUMMY {57_wisible:= 'false'} : DWORD ; //Dummy wvariable: The input wariables for the channels must be behind this wariable!
DWCORD1 : DWORD
DWCORDZ : DWCRD ;
DWORD3 : DWCRD ;
DWORD4 : DWCRD ;
DWORDS : DWCRD ;
< n |

-

i

] 4] »[®]\ Emor

Press F1 for help. [ [[n9Cal57 [iNs 4

Figure 14: SCL Source of the covering Block
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7.2 Projecting of the covering Component in the CFC

Project the adapted component ION_PN in the CFC-Plan and insert the ION_PN in a cyclic interrupt (OB3x).
The installation of the component into the OB100 takes place automatically; likewise the supply of the entrance
SAMPLE_T with the cycle time of the used cyclic interrupt is necessary.

Configure the inputs COMMAND_ID, DATA_ID, COMMAND_PORT, DATA_PORT and
CURRENT_CHANNELS of the ION_PN. Configure the inputs UIKO..UIK7 in CFC.

Finally the CPU must once be restarted (STOP, >RUN) thereby that ION SIMATIC S7 PN is initialized and a
connection to X-Tools can be established.

;r} CFC - [CFC(1) -- Laboraufbau\SIMATIC 416 PN\CPU 416-3 PN/DP\..]
Chart Edit Paste CPU Test View Options Window Help

heE & maE < 6% gin | 9 ® Bl - Q| BED N

[ New Chart
- & New Text B
s All blocks
- @ BIT_LGC
& COMPARE -
- @ CONVERT Ton e ——
@ FLIPFLOP M ecs 7 b1 N
=@ MATH_FP 1640— DRORDL | staTus cf—
@ MATH_INT 1640—|DWORD2 | statos D
1640— DWORD3
=@ MULTIPLX Il 1640—| DHORD4
@ SHIFT 1640—| DWORDS
- @ WRD_LGC 1640— DNORD6E
@ Other blacks 1640—| DNORDT s
-4 57416-3PN 1640—| DHORDE
1640—| DWORDS
1640— DWORD10
1640— DWORD11
1640—| DORD12
1640— DRORD13
1640— DWORD14
1640— DWORD15S
0—|coM RST
31—{coMann_
32— DATA_ID
1647D0— COMMRND _
164701 —|DATA_POR
1641—|DEV_ID
173 CURRENT,
16422—| UIKO
16467—|UIKL
16%43— UIK2
1640—|UIK3
1640—| UIK4
1640—|UIKS
1640— UIK6E
1641—|UIKT
1641—|TIME_BAS

1

Figure 15: Call of the adapted CFC Block ION_PN in CFC
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8 Tips and Tricks

8.1 Reset the Function Block

The ION SIMATIC S7 PN can be reset by COM_RST. This input can be connected to a bit memory which
makes it possible to reset the ION SIMATIC S7 PN at any moment easily.

8.2 Engineering during Runtime

Because of the possibility to initialize the ION SIMATIC S7 PN via input COM_RST you can add it to you project
during runtime. There is no STOP - RUN of the CPU necessary.

8.3 Changing the Number of the Function Block

The number of ION SIMATIC S7 PN (FB3) can be changed. It is just necessary to adapt the Symbol Table. It is
possible to change the numbers of FB65/FB67/FB68 by STEP 7 option “Rewire”. When you plan to rewire the
blocks it is recommended to do this in an empty project and add just the rewired blocks into you working project.

8.4 Analyzing of Connection Problems

If the interface is not able to transmit all data (OB-cycle to fast or communication too high) the variable “Dum-
my1” in the corresponding DB is rising. This can be supervised via the variable table or it can be transmitted to
X-Tools via the ION SIMATIC S7 PN.

8.5 Multi-Instancing of the ION SIMATIC S7 PN

It is possible to call multiple instances of the ION SIMATIC S7 PN in one SIMATIC CPU. This is necessary
when the required amount of data is more than 712 Byte per cycle.

Each instance of the ION SIMATIC S7 PN must be called in OB100 with COM_RST = TRUE to initialize the FB.
For each instance a separate data block and a dedicated connection pair (command and data connection) is
required. The connections are identified by COMMAND_ID, DATA_ID, COMMAND_PORT und DATA_PORT.
The parameters COMMAND _ID and DATA_ID can be taken from 0x0001 to OxOFFF. Each ID must be used for
one connection only.

The UIK must be unique for each ION SIMATIC S7 PN. The bytes UIK2...UIK7 shall be set to the MAC address
of the used PROFINET interface. To keep unique UIKs for each ION SIMATIC S7 PN the bytes UIKO and UIK1
can be numbered sequential.

The number of usable instances is limited by the capacity of the CPU. If multiple instances are called in one
controller the memory usage and cycle time of the CPU have to be checked.

8.6 Error code from TCON

If the communication is not set up the output called STATUS_CMD_TCON / STATUS_DATA_TCON from ION
PN TIA 1200/1500 FB give back the error code from TCON block.

e STATUS_CMD_TCON is used in order to set up the communication between X-Tools and the PLC in
both directions. (Declaration, exchange of command)

e STATUS_DATA_TCON is used in order to send the data from PLC to X-Tools.

For diagnostic refer to online help from TCON (Standard Library\Communication Blocks) in order to get the
meaning of the error code.
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8.7 Configuration of the Windows Firewall
If the firewall does not allow X-Tools then the communication can not start between the automation system and
X-Tools. Please verify the configuration as follow.

1. Open ,Allow a program through Windows Firewall” from the “Control Panel\System and Security” window.

. :
@k_}'lv—' » Cortrol Pamel » System and Security » ,|,,| Cearch Control Poma )
Ele Edit Yew Jook Hep

Control Panel Home Action Center
,._ Remviews e o

Troubbishost com

System and Security
Hetwork and bnternet
Hardware and Sound

Windows Firewall
Chieck furewall status

Programs

Uses Accounts and Family :!Q System

= View arr

Appearance and gt

Personalization p Windows U

Cleck, Language, and Region = Tur ¢ updeting enoroff | Check for updates | View sstalbed upsdates

Ease of Access .
y Power Options
& Require s password when the computer wakes | Change what the power buttans do
Change when the computer seeps
Jits Backup and Restore

Bach up your computer | Restore files from backup

Encryption

E a BitLocker Dr
Bectect 3 data on your disk | Marage Bitl ocker

A5, Administrative Tools
V=) Freevp

ce | Defragment your hard drive | W Create and format haed disk partitions
o e taiks

e
Flash Player (32-bit)

Figure 16: Control Panel - System and Security

2. Allow a program through Windows Firewall
a. Add “X-Tools Server Pro.exe” in the list of exception in order to allow X-Tools through Windows Fire-
wall for public and Home/Work(Private) Networks

@'Q-Iﬂ. Control Panel » System and Security » Windows Firewsll » Allowed Progeams v [ 44 || Search Contrel Pare P

Allow programs to communicate through Windows Firewall
To add, change. or remane allowed pragrams and perts, cick Change settings.

What ase the sisks of allowing a program to communicate? B Change settir
Allowed programs snd festures:

Hame Home/Work (Private)  Public
O Windews Communicaticn Foundaticn

[ Windews Firewsll Remate Management

] Windews Mansgement Instramentstion (W)
(] Windews Media Player

O windews Media Player Network Shaning Senvice
O wind ver Metwork Shanng i
O Windews Peer to Peer Collaboration Foundaton
O Windews Remote Management

[ Wireless Pestable Devices

O 'World Wide Web Services (HTTF)

B4 X-Tools Server Pro

o

BEODOOODOODOD
EDOOO0oOoocooa

| Allowe ancther program.. |

ok || cenca |

Figure 17: Allow X-Tools to communicate through Windows Firewall
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9 References

9.1 Other Documentation

e CMS X-Tools - User Manual
¢ SIMATIC System Software for S7-300/400 System and Standard Functions
¢ SIMATIC Programming with STEP 7

e http://www.siemens.com/siplus-cms
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10 Contact Information

Should you have any questions concerning the software application, please refer to the Industry Sector Tech-
nical Support.

Department
Siemens AG
Industry Sector
Phone
+49 (0) 911 895 7222 (Monday to Friday, 09:00 am to 05:00 pm CET/CEST)
Fax
+49 (0) 911 895 7223
Internet

www.siemens.de/automation/service&support

Thank you for using one of the above mentioned contacts to ensure your inquiry is registered and can be pro-
cessed.
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